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Target audience

The Open Up Guide has been prepared for use by national and local
government agencies with a mandate for or an interest in making their
land governance data open and available for others to re-use. Land
governance data generally comprises the data and information that
agencies collect as they carry out their core land administration functions
of land tenure, use, development, and value. Some countries already
collect and manage their land governance data in open and re-usable
formats. Others may be seeking advice on how to start, how to expand
their activities or how to test what they do against best practice.

Open land governance data, published in accordance with a government's
law and regulations, provides efficient and transparent government
services and enables individuals, communities, and businesses to run
their lives ethically and with integrity.

The Guide is also intended to assist communities monitoring whether
environmental protections are being upheld, and to support rights claims
over geographical areas inhabited for generations; and for civil society
organizations that can make use of land governance data to understand
patterns of land deals, support environmental and social advocacy, and
investigate and address corruption.




Background

This work to develop an Open Up Guide for Land Governance Data draws on major
international work over recent years to improve the management, availability and
accessibility of land governance data to address major ongoing social and economic issues
arising from inadequate land governance and practices globally, including land corruption.

In 2019, the State of Open Data report included a specific chapter describing the current
situation regarding the access to land governance data and outlining the two types of data
needed to understand land ownership: cadastres, which record the boundaries (both formal
and informal) of land parcels, and land registries, which record property rights and interests.

In 2019, with the support of Deutsche Gesellschaft fiir Internationale Zusammenarbeit
(GIZ) and in collaboration with Cadasta Foundation, the Land Portal Foundation's online
dialogue on open data, anti-corruption and land resulted in a draft framework of datasets
relevant to land governance.

In early 2020, The Land Portal Foundation and the Open Data Charter (ODC) partnered
to identify key core data types that should be considered for an effective land governance
framework and held an online workshop to discuss key data and key open data use-cases
for land governance.

In January 2021, the German Federal Government funded a study on The Role of Open
Data in Fighting Land Corruption: Evidence, Opportunities and Challenges. The Land Portal
convened a webinar and published an accompanying data story to discuss what it takes for
open data to have an impact on land corruption, as well as to arrive at recommendations
that can guide practitioners and policy makers. This work built upon the aforementioned
online discussion from 2019 about Open Data in the Fight Against Corruption.

Simultaneously, over 2018-2020, the Land Portal Foundation developed a methodology
to assess country level land information ecosystems, assessing the availability and
accessibility of data on: Land tenure; Land cover, use and management; Land disputes;
Human settlements; Land markets and financing; and Land, climate change and
environment. This methodology was applied to develop in-depth ‘State of Open Land
Information (SOLI)’ reports on Kenya, Uganda, South Sudan, Tanzania and South Africa.

In parallel, the Land Portal Foundation has been engaging with the development of the
Global Data Barometer (GDB), a new study backed by the International Development
Research Centre and the Open Government Partnership (OGP) (building on the Open Data
Barometer), which will provide insight into government data capability, data availability, and
data use, across 100+ countries. A land module within the GDB will provide a baseline view
on the state of open land information worldwide and assess the extent to which countries
have the frameworks in place for responsible re-use of data. It will also surface potential
case studies of land data re-use, and will provide insights to target future in-depth SOLI
reports. The survey work is taking place between March and June 2021 and the report is
due in late 2021.



http://stateofopendata.od4d.net/
https://www.giz.de/en/html/index.html
https://www.giz.de/en/html/index.html
https://cadasta.org/
https://landportal.org/library/resources/lp-oldcor-201910/open-land-data-fight-against-corruption-discussion-report
https://landportal.org/library/resources/lp-oldcor-201910/open-land-data-fight-against-corruption-discussion-report
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https://opendatacharter.net/
https://landportal.org/library/resources/towards-open-guide-land-governance
https://landportal.org/library/resources/role-open-data-fighting-land-corruption-0
https://landportal.org/library/resources/role-open-data-fighting-land-corruption-0
https://landportal.org/event/2021/02/role-open-data-fight-against-land-corruption
https://www.landportal.org/blog-post/2021/01/open-data-and-corruption-land-governance
https://www.landportal.org/debates/2019/open-land-data-fight-against-corruption
http://bit.ly/32XwBem
http://bit.ly/32XwBem
http://www.globaldatabarometer.org
https://www.idrc.ca/en
https://www.idrc.ca/en
https://www.opengovpartnership.org/
https://opendatabarometer.org/
https://opendatabarometer.org/

ODC's open up guides

The Open Up Field Guides are practical tools developed by the ODC and thematic partners
for supporting governments and other actors to use the publication of strategic datasets
to address key policy challenges. They are grounded in practical evidence while gathering
learnings to make sure global norms are applicable locally.

This Open Up Guide for Land Governance is a resource aimed to be used by governments

to collect and release land-related data to improve data quality, availability, accessibility and,

to use for improved citizen engagement, decision making, and innovation. It sets out:

»  Key datasets for land management accountability, and how they should be collected,
stored, shared, and published for improving land governance and transparency;

» Good data policies and frameworks, including metadata, standards, and governance
frameworks if available;

»  Existing gaps or challenges in the policies and frameworks; and

» Use cases from real-life examples to illustrate the potential impact and transformation
this type of data can provide in local contexts.




Problem
Sstatement

Land governance and administration

Land governance is the exercise of political, economic, and administrative authority in

a country and should include processes for citizens to participate. Responsible land
governance may therefore be seen as being about how public and private actors use, control
and provide access to land in a way that is socially legitimate and democratic (Borras &
Franco, 2010). Land is a critical global asset (socially, culturally, and economically), and is
increasingly seen as an important governance issue. Land administration and governance
problems include unequal access to land, gender discrimination, insecurity of tenure,
unsustainable land use, weak institutions, and deficient dispute and conflict resolution
mechanisms (Palmer, Fricska, & Wehrman, 2009). The quality of land governance is,
therefore, directly related to the manifestation of land tenure related problems. Land
governance improvements are needed to achieve social and economic development goals
that improve land tenure arrangements’ support.

Efforts to improve land governance align with several global initiatives. The 2030 Agenda for
Sustainable Development has land-related targets and indicators under the Sustainable
Development Goals (SDGs) 1, 2, 5, 11, 15, 16, and 17. The FAO Voluntary Guidelines on
Responsible Governance of Tenure of Land, Fisheries and Forests in the Context of National
Food Security (VGGTs) (FAO, 2012) have become a soft law instrument internationally.

The World Bank has developed the Land Governance Assessment Framework (LGAF),

a diagnostic tool to collect and assess land governance at the country level, which sets

out pre-defined criteria and associated data elements for assessing land governance
performance. Many governments, organizations, and stakeholders have committed to fully
implementing the SDGs, VGGTs, and LGAF to monitor land-related indicators and assess
performance in order to improve and promote responsible land governance.

The UN Framework for Effective Land Administration (FELA) acts as an overarching policy
guide, providing a reference for UN Member States when developing, renewing, reforming,
strengthening, modernizing, or monitoring land administration. It seeks to implement the
Integrated Geospatial Information Framework to the land sector.

The Land Portal Foundation and the Global Land Tool Network (GLTN)'s dashboard, which is
financially supported by the Omidyar Network, promotes SDG land monitoring (Land Portal,
2021). LANDex, the Global Land Governance Index developed by the International Land
Coalition (ILC, 2021), measures progress towards ILC's people-centred land governance.
This allows users to monitor the implementation of the global development frameworks,
such as the Sustainable Development Goals (SDGs) and the VGGTs,



https://www.landportal.org/book/sdgs
http://www.fao.org/tenure/voluntary-guidelines/en/
http://www.fao.org/tenure/voluntary-guidelines/en/
http://www.fao.org/tenure/voluntary-guidelines/en/
https://openknowledge.worldbank.org/bitstream/handle/10986/2376/657430PUB0EPI1065724B09780821387580.pdf?sequence=1&isAllowed=y
https://ggim.un.org/meetings/GGIM-committee/10th-Session/documents/E-C.20-2020-29-Add_2-Framework-for-Effective-Land-Administration.pdf
http://ggim.un.org/meetings/GGIM-committee/8th-Session/documents/Part%201-IGIF-Overarching-Strategic-Framework-24July2018.pdf
https://www.landportal.org/book/sdgs
https://sdgs.un.org/goals

Benefits of effective land management

The 2020 Framework for Effective Land Administration (FELA) (UN-GGIM, 2019) states that
effective land administration caters to all people, and will:

» develop confidence and trust and promote security, safety, and peace building;
» increase the proportion of population with tenure security;

» allow economic development by supporting land value capture and revenue systems
that are equitable and transparent;

»  strengthen multi-disciplinary and multi-sectoral participation t
0 achieve integrated geospatial information;

» contribute to smart and resilient rural and urban societies,
with equitable spatial/land-use planning, and land development;

» ensure participatory and inclusive land use, and land use planning;

» promote the recognition of the inherent rights of indigenous and vulnerable peoples
to their lands, territories, and resources, and recognise collective traditions, customs,
and customary tenures, consistent with existing obligations under national and
international law;

» encourage efficient, sustainable, and fair land markets, where appropriate,
that take into account land tenure, value, use, and land development aspects;

»  cater to all circumstances, situations, and people - in times of peace and prosperity,
in times of stress and hardship (including disaster and conflicts, forced migration
and human displacement, poverty, food, and water scarcity);

» enable partnerships, bringing and building together knowledge, skills, and experiences
on land tenure, land value, land use, and land development; and

»  promote preparedness and resilience on climate change issues, and support
biodiversity, conservation, and ecosystem sustainability.

Effective land management data

The land-related data, information, and indicators necessary for monitoring performance
need to be readily available, timely, standardized, and widely distributed to increase their
impact. Historically the cadastre might have provided the legal property and its associated
rights and obligations. However, modern land administration theory (Williamson, Enemark,
Wallace, & Rajabifard, 2010) now prioritizes the management of land and associated
resources to respond to national and global imperatives such as poverty reduction,
sustainable agriculture, sustainable settlements, economic development, conflict
management, and climate change. The emphasis is no longer on the legal property,

but rather on the management of the spatial object and the role of the associated land
management functions to support sustainable social, economic, and environmental
management (Zevenbergen, De Vries, & Bennet, 2016; Williamson, Enemark, Wallace,

& Rajabifard, 2010). Land governance data must now include data on the core land
administration functions of land tenure, use, value, and development.




The sources of this land governance data are varied and include the national governments;
some data may be collected by international organizations, some locally by civil society
organizations and individuals, and some data might not be collected at all.

Improved land governance and the democratization of land management functions
coincide with the development of the open data movement. By 2015, the open data
movement had “made explicit the potential links between open data and sustainable
development” (Davies, Walker, Rubenstein, & Perini, 2019), and open data had started
to find its place alongside global thematic and sectoral initiatives, for example global
development, with the SDGs using open data as a critical tool to monitor development
efforts (Hammer, 2019; Gurin, Bonina, & Verhulst, 2019).

The Open Definition states that “Data is open if anyone is free to access, use, modify, and share
it — subject, at most, to measures that preserve provenance and openness” (Open Definition
2.1). The Open Data Charter (ODC) works for a world where governments collect, share, and
use well-governed data to respond effectively and accountably to the most pressing social,
economic, and environmental challenges of our times. The ODC global principles state that
data should be open by default, timely, and in a comprehensive, free, accessible, and usable
format. This will enable public uptake and use of the data and ensure that it is comparable
and interoperable to facilitate analysis. Through its ‘publishing with purpose approach’,

the ODC encourages governments to take small steps that yield quick wins: it prioritizes
opening up and enabling use of quality data to help address globally relevant problems and
developing a trustworthy data governance framework to achieve this goal.

Accessibility and the capacity and empowerment to use open data are key to making

data a relevant factor in good land governance (Jaitner, Schilling, & Matthaei, 2020). The
developments in land administration theory and open land data offer social and economic
benefits as well as democratic change to the land governance sector. Land registers and
cadastres have historically been open to the public in analogue formats, but digitization
has bypassed many. Innovations and advances in information technology tools and
geographic information systems allow for improved access and availability of open land
data while providing for protection of personal and restricted data. Within the GODAN
Action Project the Land Portal Foundation has worked to understand the data standards
relevant for land governance data and explored gaps in land data standardisation.

The Land Data chapter in the report on “The State of Open Data” (2019), Davies & Chattapadhya,
states that despite “large donor investments in land registration Systems, few resources are
currently made available to enable open data related to these projects” and that this represents
untapped opportunities. It argues that interventions regarding open data standards,
infrastructures and ecosystems need to consider that land data is political in nature.

Land Portal has developed a methodology to assess country level land information
ecosystems. This methodology, which assesses the availability and accessibility of data on:
Land tenure; Land cover, use and management; Land disputes; Human settlements; Land
markets and financing; and Land, climate change and environment, has been applied to
develop in-depth ‘State of Open Land Information (SOLI)’ reports on South Africa, Kenya,
Uganda, South Sudan, and Tanzania.



http://opendatacharter.net
http://opendatacharter.org/principles
https://opendatacharter.medium.com/publishing-with-purpose-introducing-our-2018-strategy-ddbf7ab46098
https://www.godan.info/pages/action
https://www.godan.info/pages/action
https://f1000research.com/documents/7-1697
https://f1000research.com/documents/7-1697
http://bit.ly/32XwBem
http://bit.ly/32XwBem

The Columbia Center on Sustainable Investment's OpenLandContracts is a repository of
publicly available contracts and associated documents created to strengthen the growing
campaign for information disclosure around land-based projects and to demonstrate that
contract transparency is both feasible and valuable. The site includes full text of contracts
and related documents (in PDF form); summaries (or “Annotations”) of each contract's key
social, environmental, human rights, fiscal, and operational terms; and tools for searching,
sharing, and comparing contracts and their key terms.

Land corruption

Corruption is a major issue in the land sector and open data has been shown to be a
powerful tool to combat it. NUST-NELGA Hub for Southern Africa (2019) reports that:

“In Southern Africa, legal reforms to secure land tenure, redistributive land reforms
and attempts to practice good land governance all try to reduce inequalities in
access, ownership or use of land. However, none of these initiatives have abolished
existing inequalities in assets deeply embedded in (colonial) history or avoided
generating new ones. Population growth, corruption, poorly implemented land
reforms and gender insensitive policies are major reasons for failure. These failures
become more visible in rural areas. However, they are also gaining in importance in
urban informal settlements”.

Research commissioned by GIZ reveals overwhelming support for the use of open data as
an anti-corruption tool in the land sector, and strong evidence that there is a high degree of
untapped potential (De Maria & Howail, 2021). It reports that “the lack of transparency and
openness in land information systems, together with the presence of overlapping and sometimes
conflicting tenure systems in many countries around the world, creates a perfect environment for
corruption to thrive in many areas related to land governance”.

It further says that “land corruption is a sectoral form of corruption that affects both urban and
rural areas, and disproportionately affects vulnerable and marginal groups in society”. It sets out
recurrent negative implications of land corruption:

» It can reduce the ability of small-scale farmers to increase agricultural productivity;

» It can contribute to restricted access to land for specific groups, especially for those who
rely on this vital resource for their livelihood;

» It can contribute to money laundering;

» It can exacerbate gender inequalities, favoring gendered forms of discrimination in land
and property inheritance;

» It can lead to fundamental human rights violations, such as forced evictions; and

» It may lead to social unrest, land conflicts, and land disputes across the world.

The report concludes that building greater consensus on open land data and information
initiatives, as well as producing further compelling evidence to demonstrate their impact in
eradicating land corruption, are crucial elements for unlocking this potential.



https://openlandcontracts.org/

Towards an open up guide on land governance

This Open Up Guide for Land Governance led by the Land Portal Foundation and the Open
Data Charter seeks to complement and contribute to the ongoing work on open data and
land governance. The Open Up Guide:

» Documents lessons from international initiatives on open land governance data and
information;

»  Outlines the barriers, risks, and challenges to open data such as the lack of resources,
technical capacity, and systems to interact with data and the complexity of the datasets;

»  Describes the opportunities and challenges associated with open land data and balances
the social, cultural, and economic benefits realized with equity, indigenous sovereignty,
privacy, and security concerns;

»  Sets out agreed key land governance data types, how they should be collected, stored,
and published for improving land governance and transparency; and
»  Showcases use cases from real-life examples to illustrate the potential impact, and

» Demonstrate the transformation open land data can provide in local contexts.

The Guide is intended to help improve data quality, availability, accessibility, and use for
improved citizen engagement, decision making, and innovation. It also complements the
practical guidance set out in the Open Data Charter's Open Up Guides on Anti-corruption,
Climate Change and Agriculture.



https://opendatacharter.net/resources/?type-post-resources=guide
https://opendatacharter.net/resources/?type-post-resources=guide

Open land

governance data

Open data is "digital data that is made available
with the technical and legal characteristics necessary
for it to be freely used, re-used, and redistributed by
anyone, anytime, anywhere". It is structured data
that can be downloaded for legal use, analysis, and
re-use. It does not include digital documents and
information, such as policy documents or research
reports that analyse data.

Publishing open data requires countries and
international organizations to apply common
standards and policies so that personal and
restricted data is protected, data formats are
consistent, and the data can be used legally
locally and globally. These common standards and
policies enable better decision making and offer
efficiencies in national and local organizations and
communities that collect and manage data.

Codes of conduct are also emerging to cover the
sharing of sensitive data to protect all involved from
the risks of data sharing. The codes of conduct
provide principles that parties considering data
sharing agreements may apply in such contracts.
An example is GODAN'’s codes of conduct, voluntary
guidelines and sets of principles around how to
transparently govern farm data. This online tool
provides the conceptual basis for general, scalable
guidelines for everyone dealing with the production,
ownership, sharing, and use of data in agriculture.

A key open data issue is the rights of indigenous
people to control information and data about
themselves and their lands, individually and
collectively. Indigenous Data Sovereignty, which
focuses not only on data issues, but also on asking
fundamental questions about power relations

and land governance (colonial and postcolonial),
forces the open data community to respond to and
consider these dynamics.

Open land governance data can be used to
support land claims and provide public evidence
of land ownership, thereby reducing corruption
opportunities and offering a route to greater
public empowerment. It helps communities
monitor whether environmental protections are
being upheld, and supports rights claims over
geographical areas inhabited for generations.

It helps civil society organizations understand
patterns of land deals, support environmental
and social advocacy, and investigate and address
corruption.

There is very little global evidence of open land
governance data. International indices show that it
is currently restricted to land tenure data in a small
number of developed countries such as Canada,
South Korea, Australia, and New Zealand, which
have sophisticated land information systems.


https://opendatacharter.net/principles/
https://www.godan.info/codes
https://stateofopendata.od4d.net/chapters/issues/indigenous-data.html
https://index.okfn.org/dataset/

They release cadastre data (boundaries of land
parcels) and land registries (property rights
and interests and some details of ownership
of particular parcels of land) as open data.
They routinely publish geospatial (linked to

a location reference point) data as open data.

Governments rarely publish data collected

for administering the other land administration
functions of land use, value, and development as
open data. The 2019 research undertaken for the
State of Open Data report (p187) “could not locate
any sources indicating the extent to which different
countries provide structured data on government
land holdings, their purchases and disposals”.

It noted individual instances of some open data,
for example, the UK government’s open datasheet
of overseas companies that own property

in England and Wales but no corresponding
datasheet showing the land that has been sold
off, or off-shore deals.

Some national and local governments sell their land
and property sales data, thereby earning revenue to
assist with the costs of maintaining their information
systems. Others contract this work to private
organizations that also usually sell it.

International open land data is generally geospatial
data or aggregated data from international surveys
or national statistical offices. It is released by
international organizations such as the World Bank,
United Nations, and bi-lateral donor organizations,
e.g. World Bank Official Boundaries. The Land
Portal offers a wide range of statistical data
aggregated from trusted providers.

Publishing land data in open formats can place

a burden on countries if the process is not built
into existing systems and understood by those
creating and managing the data. Ideally it requires
digital information systems designed with an
open-by-default capability which also protects
personal and restricted records.

Itis crucial for countries to set policy which
protects the privacy and security of individuals

in order to gain their confidence. For example,

New Zealand requires all users of its open land
ownership data to agree to a separate licence
before they can use, reuse, and share the property
and ownership layers that contain personal
information. This does not apply to public elements
of the data in the Land Information New Zealand
Data Service.

The developing countries which are undertaking
projects to upgrade their legacy paper-based
information systems, with the support of
development banks, do not appear to be including
an open data component. Open data systems
may also help to bridge the management of data
collected by community groups/private individuals,
when existing national systems are incomplete or
minimal. Open data systems are also able to take
advantage of new methods for collecting land
data, such as GPS, satellite, and mobile phone
technologies to help bridge this information gap.

The land data types identified below aim to help
countries upgrade their information systems,

plan and implement their open data projects, or
consider options for doing so. They set out the key
land governance data types, list the required data
standards, and give examples of countries and
organizations that release open data or are on the
journey to do so.



https://www.stateofopendata.od4d.net/
https://use-land-property-data.service.gov.uk/datasets/ocod#example
https://use-land-property-data.service.gov.uk/datasets/ocod#example
https://use-land-property-data.service.gov.uk/datasets/ocod#example
https://datacatalog.worldbank.org/dataset/world-bank-official-boundaries
https://landportal.org/book/data
https://landportal.org/book/data
https://www.linz.govt.nz/data/licensing-and-using-data/linz-licence-for-personal-data
https://data.linz.govt.nz/
https://data.linz.govt.nz/

Land data

assessment frameworks

Numerous international instruments and
frameworks have been developed to assess

and promote good land governance. At the global
level, and perhaps best known, are the Sustainable
Development Goals (SDGs) of the United Nations
(UN), which recognise that poverty eradication

is the single biggest challenge to ensuring
sustainable development. The UN has developed
17 goals with 169 corresponding targets.

Each target has one or more indicators associated
with it. While there is no explicit goal on land
governance, many of its targets and indicators
relate to land governance.

LANDex aggregates data sources, including
governments' administrative data, household
surveys, people-based assessments, including
the perspectives of unaffiliated individuals, and
participatory or community-generated data.

Its methodology is based on a set of “710 /LC
commitments to people-centred land governance”
incorporating 33 indicators (LANDex, 2021).

Prindex is a global perception-based index using

a random sampling of interviewees in every
country (PRINDEX, 2020). The PRINDEX (2020)

is focused on a single comparable indicator, tenure
security, to "assess how respondents feel about the
security of their tenure, not their legal status”.

The Land Matrix “promotes transparency and
accountability in decisions over large scale land
acquisitions in low- and middle-income countries

by capturing and sharing data about these deals

at global, regional, and national levels" (Land Matrix,
2021) and tracks indicators on the size, number,
and status of deals.

The Land Governance Assessment Framework
(LGAF) was developed by the World Bank (World
Bank, 2012) and applied by scholars (Deininger,
Selod, & Burns, 2012) as well as in a modified
form in the Land Governance Scoping Study

for Southern Africa (Bayer, Enemark, & Kirk, 2020).
The LGAF tool assesses land governance over

5 themes and numerous indicators resulting

in performance scores across 80 dimensions

as rated by national land experts.

Scholars (Burns & Dalrymple, 2008) have
developed a conceptual framework for good
governance in land administration that includes
a set of principles and corresponding indicators.
Other frameworks for land governance include
the FAO's Voluntary Guidelines for the Responsible
Governance of Tenure of Land, Fisheries and
Forests in the Context of National Food Security
(FAO, 2012). Koroso, van der Molen, Tuladhar,

& Zevenbergen (2013) developed an assessment
framework for urban land use rights in China.



A common characteristic of these frameworks

is that they attempt to assess the state of land
governance based on perception, interviews,
surveys and other data. These approaches rely
primarily on secondary data, rather than on the
primary data produced by the land governance
activities. They tell us a lot about how countries
are performing with regards to broader land
governance principles.

The Global Land Indicators Initiative (GLII)
indicators, developed by the Global Land Tool
Network, focus on tenure security, land conflicts,
land administration services, and land use
(Quan & Kumar, 2017) and assess land data
based on the land administration and
governance functions. The GLIl is also engaged
with the Africa Centre for Statistics to fast-
track land data generation, analysis, reporting
and development of a land data repository.

The GLII mandate includes support to land

and statistical institutions to collect gender
disaggregated data, analysis and reporting,

and the adoption of new data technologies.

It promotes evidence-based approaches to land
monitoring, impact measurement of tenure
security measures, policy influencing, and use
of open land data repositories. Finally, the GLII
supports the application of analytical tools

for open data repositories, commonly agreed
indicators, tools for data collection that are
accessible and affordable, and development

of regularly updated open datasets, including
reliable technical solutions for land data
gathering on informal tenures (GLII, 2017).

The State of Land Information Methodology,
developed by the Land Portal, has three
elements: scoping the information landscape
in a country, an open data compliance
assessment, and targeted capacity building
interventions based on open data assessment
and associated recommendations designed
to achieve improvement in information
management practices.

This methodology assesses both the availability
and the accessibility of data on land tenure; land
cover, use and management; land disputes; human
settlements; land markets and financing; and land,
climate change, and environment. It has been
applied to develop in-depth ‘State of Open Land
Information (SOLI)' reports on Kenya, Uganda,
South Sudan and Tanzania, and South Africa.

These reports “uncover the country’s land data

and information ecosystem and provide a framework
to democratize and improve it". They focus “on the
database or dataset and its sources” and identify
“trends and gaps when it comes to land data
collection, as well as how accessible it is on the world
wide web" (Napier, et al., 2020).

In the same way, this Open Up Guide is assessing
the accessibility and the availability of land data
that a well-functioning land administration system
and its associated functions are expected to
produce. It documents the types of data and
information required to contribute to good land
governance. While it focuses on the primary data
produced by the land administration functions,
some secondary data is also included.
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Land data

Unlike other types of data, land data has an
intrinsic spatial element. While text data can
contribute much about land and rights, it's
singularly enriched when incorporating the
spatial aspects of a land record. This generally
adds an additional layer of complexity for the

administration, management, and analysis of data.

However, in land administration systems there

is an implicit understanding and expectation

that spatial data is the norm, rather than the
exception. This Guide includes and distinguishes
between spatial data and non-spatial data and
accepts this as a necessary precondition for
discussion on land data for improved governance
of land and associated resources.

The online workshop “Towards an Open

Up Guide for Land Governance”, held in

March 2020, identified the core data needs

for opening up data on land governance.
These are information on i) land parcels, ii) land
use, iii) land transactions, iv) and performance
of land governance functions. The workshop
also identified additional seven data needs
relating to land valuations, tax collection, policy
evaluation, and the decision-making framework
around land. These data needs correspond very
closely with the primary functions of a modern
land administration system geared towards
supporting sustainable development and good
land governance.

The March 2020 workshop provided a foundation
for the Open Up Guide to use the new theory of
land management as the conceptual framework
for land administration, including the typical
functions that need to be carried out for good
land governance. Land governance data therefore
includes data and information on the core land
administration functions of land tenure, use,
value, and development.

This approach and the key data types which relate
to each function were validated at an online
workshop run by the Land Portal Foundation and
the Open Data Charter in April 2021.

The land administration functions are:

» Land Tenure: the processes and institutions
related to securing access to land and
inventing commadities in land and their
allocation, recording, and security; cadastral
mapping and legal surveys to determine
parcel boundaries; creation of new properties
or alteration of existing properties; the
transfer of property or use from adjudication
of doubts and disputes regarding land rights
and parcel boundaries.

» Land Value: the processes and institutions
related to assessment of the value of land
and properties; the calculation and gathering
of revenues through taxation; and the
management and adjudication of land
valuation and taxation disputes.


https://www.landportal.org/library/resources/towards-open-guide-land-governance
https://www.landportal.org/library/resources/towards-open-guide-land-governance
https://landportal.org/event/2021/03/open-guide-land-governance
https://landportal.org/event/2021/03/open-guide-land-governance
https://landportal.org/event/2021/03/open-guide-land-governance

» Land Use: the processes and institutions
related to control of land use through
adoption of planning policies and land-use
regulations at the national, regional, and local
level; the enforcement of land-use regulations;
and the management and adjudication
of land-use conflicts.

» Land Development: the processes
and institutions related to building new
physical infrastructure and utilities; the
implementation of construction planning;
public acquisition of land; expropriation;
change of land use through granting of
planning permissions, and building and
land-use permits; and the distribution
of development costs.

Although the Open Up Guide focuses on

public sector data collected or administered

by national and local governments, there might
be other types of data collected by international
organizations, civil society organizations, private
enterprises, and individuals. If this is the case,
this Guide suggests ways for regulating and
sharing data among these stakeholders to enable
a good land governance framework.




g1 01 9~ == 77

91 01 01 91 01 01

1 01 gl 01 g1 01 01
, 01 01 01 01 0101
1 o1 01 01 01 01 01
g1 01 01 01 91 01 01

, 01 01 01 01 01 00
91 01 01 01 00 00 00 00 01 @1 01 01

91 01 01 01 00 o 90 00 00 o1 01 01
01 01 01 00 00 op 90 00 00 Q0 01 o
0l 01 00 00 00 Qo Y0 00 00 00 01
oL 01 00 00 00 0o 90 00 00 @0 90 |

1 00 00 00 00 Qo 90 00 00 00 00
01 01 00 00 00 op 90 00 00 00 00

(gi:LL 21 01 00 00 0o 90 0o 00 00 00 O
- @161 00 00 oo 90 pp 00 00 01 O
- 21 01 00 oo @0 gp 00 01 01 01
1 0L o1 1 01 0p gp 00 gp 00 01 01 01
- ®1m 01 o1 oo 90 gp 01 01 01 01
o1 01 o1 01 01 g1 o1 90 gp 01 01 Ol 01

01 01 @1 1 00 pp 01 01 01 01 ©

01 01 @1 @1 01 Q1

01 01 01 @1 01 91 o1
01 01 01 @1 Q1 01 @1
01 01 01 g1 91 91 o1
00 01 01 o1 91 91 ¢
00 00 01 01 01 01



o

\. J

Key

data types
for land
governance




Table 1: Spatial Land Tenure Data

DESCRIPTION TYPE DATA STEWARD STANDARD

PARCEL DATA SET CADASTRE: SURVEYED PARCEL BOUNDARIES

Information contained in the National Cadastre. This is a record of all surveyed parcels nationally. Encompasses urban and rural » Spatial Vector » Surveyor General or » 1SO 19152:2012 Land
land parcels. Also includes sectional parcels removed from the surface of the earth (3-D) Equivalent Administration Domain
»  Coordinate System: Ellipsoid, Geoid, Projection Model (LADM)

» Parcel ID: Unique Parcel Identifier, Lot Number
» Parcel Dimensions: Area, Length of sides, Coordinates

» Parcel Description: Township, Reference Plan, Sectional Plan

Land tenure data

. . . PARCEL DATA SET CADASTRE OF TRADITIONAL/INDIGENOUS OR CUSTOMARY LAND PARCELS
Table 1 lists only spatial data and typically

involves cadastral mapp]ng and |ega| surveys Contains information on customary land parcels. Identification of parcels could be by name and rough location only. » Spatial Vector » Minister Responsible » 1SO 19152:2012 Land
. ) Sometimes stored by Government agencies where customary rights are legally recognised. Often deregulated and stored for Traditional or Administration Domain
to determine parcel boundaries as well as by traditional authorities in a distributed manner and across a range of formats and may be subject to the CARE principles Indigenous Affairs Model (LADM)
the creation of new properties or alteration for Indigenous Data Governance. Information, if documented, might not be digital. N Traditional or
of existing properties and their boundaries » Coordinate System: Ellipsoid, Geoid, Projection Indigenous Authorities
» Parcel ID: Unique Parcel Identifier, Customary Lot Number, Locality Name » Individuals

It also lists sectional titles (condominiums,

o / » Parcel Dimensions: Area, Length of sides, Coordinates, Location
apartment buildings) where the boundaries

» Parcel Description: Traditional Authority Area, Reference Plan, Locality Plan, Locality Name
are removed from the surface of the earth
and may float in space and be depicted in three PARCEL DATA SET CADASTRE OF SETTLEMENTS, PARCELS OR STRUCTURES
dimensions. In trad|t|onal/|nd|genous or customary Contains information on the location of urban land parcels. Often these parcels might be documented by the local authorities » Spatial Vector » Minister responsible for — » 1SO 19152:2012 Land
settings special care should be taken to consider responsible for the area. Sometimes also involves Traditional Authority structures, especially in peri-urban areas. Local Government Administration Domain
. . . Often deregulated, distributed and stored across a range of formats. - Model (LADM,
issues around Indigenous Data Sovereignty. s s » Local Authorities (tADM)
» Coordinate System: Ellipsoid, Geoid, Projection N Traditional or
» Parcel ID: Unique Parcel/Structure Identifier, Informal Lot Number Indigenous Authorities
» Parcel Dimensions: Area, Length of Sides, Coordinates (Point Coordinate) » Community Based
»  Parcel Description: Settlement Area, Reference/Community/Municipal Plan Organisations
» Individuals
PARCEL DATA SET SURVEYED ROADS AND UTILITIES
Contains information on roads and other public services. Some services might be linear (power lines) but are typically buffered » Spatial Vector » Minister responsible for ~— » 1SO 19152:2012 Land
by easements/servitudes. These easements are sometimes, but not always registered or surveyed. Thus, it is important that the Public Works Administration Domain
location of physical infrastructure is known. N Utility Companies Model (LADM)
» Coordinate System: Ellipsoid, Geoid, Projection N Local Authorities

» Feature Type: Road, Powerline, Water Services, Sewerage, ITC infrastructure
» Legal Buffer Zone: Distance within service where development is prohibited.
» Feature Location: Coordinates

» Feature Description: Length, Depth, Height, Width, Diameter, Load
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Table 1: Spatial Land Tenure Data (continued)

DESCRIPTION TYPE DATA STEWARD STANDARD

PARCEL DATA SET GEOLOGICAL/MINERAL RESOURCES SURVEY

Typically mining resource rights, leases and parcels as demarcated by the geological surveys. » Spatial Vector » Geological Survey » Committee for Mineral
May contain data relating to Geochemical, Geophysical, Geological Data > Raster N Ministry responsible Reserves International
»  Coordinate System: Ellipsoid, Geoid, Projection for Mines Reporting Standards

» Claim License Holder: Natural or Juristic Entity (Shareholding) (CRIRSC)

» Claim ID: Unigue Claim Identifier

» Claim Dimensions and Location: Area, Length of Sides, Coordinates (Point Coordinate)

» Claim Description: Type of License (Prospecting, Mining)

» Claim Type: Base Metals, Industrial Minerals, Precious-Semi Precious Minerals/Metals

» Base Geological Data: Geochemical, Geophysical

PARCEL DATA SET NATURAL RESOURCES AND ENVIRONMENTAL MAPPING

This could include information on the use of natural resources rights such as forest products including leases » Spatial Vector » Ministry responsible » Not Applicable

and community uses and protected areas. for Forestry and

Environment.

» Raster
» Coordinate System: Ellipsoid, Geoid, Projection

» Forestry or Natural Resources Claims/Licences: Natural or Juristic Entity (Shareholding)
» Forestry or Natural Resources Claims/Licences ID: Unique Claim Identifier

» Forestry or Natural Resources Claims/Licences Dimensions and Location:
Area, Length of Sides, Coordinates (Point Coordinate)

» Base Natural Resources Data: Land Cover, Soil Type, Vegetation



http://www.crirsco.com/national.asp
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Table 2: Non-spatial Land Tenure Data

DESCRIPTION TYPE DATA STEWARD STANDARD

DATA TYPE REGISTER OF SURVEYED PARCEL OWNERSHIP AND RIGHTS

Typically, the information contained on the National Land Register. This is a record of all surveyed parcels » Non-spatial » Registrar General or Equivalent » 1SO 19152:2012 Land Administration
and the associated rights. Typically encompasses urban and rural land parcels. Domain Model (LADM)
Includes all new transactions.

» Parcel ID: Unique Parcel Identifier, Lot Number

» Parcel Owner: Natural/Juristic Person (Name, Gender, Identification/Company Registration Number)
» Deed/Title Number: Reference to Legal Instrument of Rights

Table 2 lists the non-SPatia| data deSCriptiOﬂS » Title Registration: Effective Date of Registration/Transfer

of the corresponding spatial datasets. »  Type of Rights: (Ownership, Sectional title, Leasehold rights)

In fUHy integrated cadastres these data types » Restrictions: Servitudes, Easements, Mortgages

might be contained in one database but this
is not always the case. For the purposes of

DATA TYPE REGISTRY OF TRADITIONAL/CUSTOMARY OR INDIGENOUS LAND RIGHTS

clarity they are expressed here as se pa rate Contains information on customary land rights. Rights could be individual or group rights. » Non-spatial » Minister responsible » IS0 19152:2012 Land Administration
!
) ) ) May also be leased out for commercial purposes to non-traditional members. Stored by Government for Traditional Affairs Domain Model (LADM)
non-spatial (or attribute) data types that contain agencies if customary rights are legally recognised. Often deregulated and stored by traditional authorities »  Traditional, Indigenous, Customary
the component. They would typically detail in a distributed manner and across a range of formats and may be subject to the CARE IDG principles Authorities
) ) for Indigenous Data Governance. Information, if documented, might not be digital. »
the type of rights held (leasehold, licence, use, Predominantly rural phenomenon. »  Individuals
ownership etc), the duration of such rights, and »  Parcel ID: Unique Parcel Identifier, Lot Number, Locality Name
the identity of the |ega| entity hO|diﬂg such I’ightS. » Parcel Owner: Natural/Juristic Person (Name, Identification/Company Registration Number)
» Instrument Number: Reference to Legal Instrument of Rights

Often the non-spatial information could also

contain financial information such as the cost
of the rights, mortgages if any, and dues that
are liable or benefits that may be accrued.

» Registration: Effective Date of Registration/Transfer
» Type of Rights: (Ownership, Customary, Leasehold rights)

» Restrictions: Use rights, Group Rights, Servitudes, Easements, Mortgages

DATA TYPE REGISTRY OF INFORMAL LAND RIGHTS

Contains information on the rights to urban land parcels held by individuals. Often these rights might » Non-spatial » Minister responsible » 1SO 19152:2012 Land Administration
be documented by the local authorities responsible for the area. Sometimes also involves Traditional for Local Government. Domain Model (LADM)
Authority structures, especially in peri-urban areas. Often deregulated, distributed, and stored across a N Local Authorities.

range of formats. Predominantly Urban and peri-urban phenomenon. . ) .
» Traditional and Indigenous Authorities

» Parcel ID: Structure, Unique Parcel Identifier, Lot Number o

» CBOs & Individuals
» Parcel Owner: Natural/Juristic Person (Name, Identification/Company Registration Number)
» Instrument Number: Reference to Legal Instrument of Rights

» Registration: Effective Date of Occupancy/Registration/Transfer
» Type of Rights: (Occupancy, Ownership, Customary, Leasehold Rights)
» Restrictions: Use rights, Group Rights, Occupancy Rights
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Table 2: Non-spatial Land Tenure Data (continued)

DESCRIPTION DATA STEWARD STANDARD

DATA TYPE SURVEYED ROADS AND UTILITIES

Record the ownership of polygons, line, or point features such as roads, electrical, water and other cables » Non-spatial » Minister responsible » 1SO 19152:2012 Land Administration
and pipelines or wells. Sometimes part of the land registry (ownership or easement/servitude) but in many for Public Works. Domain Model (LADM)

instances unregistered and not indicated as part of the parcel fabric, but as part of the utility company or
government department.

» Utility Companies

» Local Authorities
» Feature Type ID: Polygon, Line or Point ID

» Feature Owner: Entity Name or Company Registration
» Type of Rights: Ownership, Leasehold, Easement
» Registration: If applicable, date of registration, acquisition or installation of infrastructure

» Detail of Feature Type: Road (According to Legal Classification), Powerline
(According to Legal Classification)

» Legal Buffer Zone: Distance within service where development is prohibited
» Restrictions: Any Development Restrictions associated with the feature

» Feature Description: Length, Depth, Height, Width, Diameter, Load

DATA TYPE GEOLOGICAL/ MINERAL RESOURCES SURVEY

Typically, the ownership or rights holders of mineral and other resources and parcels as demarcated by » Non-spatial » Geological Survey » Committee for Mineral Reserves
the geological surveys. May contain data relating to different types of licenses and rights and durations.. International Reporting Standards
(CRIRSC)

» EITI Standard

» Ministry responsible for Mines
» Claim ID: Unigue Claim/Resource Identifier

» Claim License Holder: Natural or Juristic Entity (Shareholding)

» Registration Date: Effective date regarding acquisition of rights.

» Claim Description: Type of License (Prospecting, Mining)

» Claim Type: Base Metals, Industrial Minerals, Precious-Semi Precious Minerals/Metals

» Base Geological Data: Geochemical, Geophysical

DATA TYPE FORESTRY/ENVIRONMENTAL MAPPING

Typically, Forestry information, including leases, permit holders, community uses and protected areas. » Non-spatial » Ministry responsible » Not Applicable
Would indicate whether private or public forest or conservation area. In some jurisdictions could also be for Forestry and Environment.

commercial forest plantations, community uses or communal/community forests.

» Forestry or Natural Resources Claims/Licences ID: Unique Claim Identifier

» Forestry or Natural Resources Claims/Licences: Natural or Juristic Entity (Shareholding)

» Registration Date: Effective date regarding acquisition of rights

» Forestry or Natural Resources Claims/Licences Description: Type of License (Harvesting, Use)

» Forestry or Natural Resources Claims/Licences Type: Hardwoods, Thatching Grass, Forest Fruits
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Table 3: Land Value Data

DESCRIPTION TYPE DATA STEWARD STANDARD

DATA TYPE LAND VALUE (OPEN MARKET)

Typically, the information contained on the National Land Register. Includes all new transactions as well as their » Non-spatial » Registrar of Deeds/Titles » 1SO 19152:2012 Land
value. Mortgage information is also recorded. N Land Registry Administration Domain Model
» Parcel ID: Unique Parcel Identifier, Lot Number N Valuer General or Equivalent (LADM)
» Parcel Owner: Natural/Juristic Person (Name, Identification/Company Registration Number)
» Deed/Title Number: Reference to Legal Instrument of Rights
L d | » Value: Commercial/Private Valuation of Property
a n Va u e » Purchase Price: Price paid for Transaction
This should contain all the information regarding » Type of Rights: (Ownership, Sectional title, Leasehold rights)
. . . » Land Use: Zoning or Use Rights on Parcel (Industrial, Commercial, Residential, Agricultural)
land valuations and transfers so that information . ,
] o » Restrictions: Servitudes, Easements, Usufruct
on the land market and its functioning may be
derived. It should include information on the DATA TYPE LAND VALUATION (FOR TAXATION)
processes, valuations, and tax rates of all parcels . - . . . . . ; ;
. ) Most Local and National authorities publish a valuation roll for the purposes of rates and taxation. » Non-spatial » Valuer General or Equivalent » International Valuation
of land in the cou ntry. Increasmgly Iarge—scale These public values are distinct from the private valuation for commercial transaction and mortgaging. N Local Authorities Standards (IVS)

These values are updated on a regular basis usually pre-defined (annual or up to five-year cycles). N 1SO 19152:2012 Land

» Parcel ID: Unique Parcel Identifier, Lot Number Administration Domain Model

investments in land from non-national entities
globally are a cause for concern. While their

» Parcel Owner: Natural/Juristic Person (Name, Identification/Company Registration Number) (LADM)
impaCt is still being debated (MU”EI’, etal, 2021; » Deed/Title Number: Reference to Legal Instrument of Rights
Hufe & Heuermann, 201 7)/ data on the |arge » Value: Public Valuation of Property (Valuation Roll)
international land investments could prove to »  Date: Date of Current Valuation
be a valuable contribution to understanding and » Period: Duration or Period of Validity of Valuation Roll
SUbSGqU6ﬂt|y improving land governance. » Method: Method used to determine Valuation
» Type of Rights: (Ownership, Sectional title, Leasehold rights)
» Land Use: Zoning or Use Rights on Parcel (Industrial, Commercial, Residential, Agricultural)
DATA TYPE LOCAL/NATIONAL PROPERTY TAXATION
Publish information on the value for taxation of municipal/national properties. This may be done per local authority » Non-spatial » Local Authorities » International Valuation
and/or nationally. Rural and agricultural land may be subject to similar valuations for taxation based on national N Ministry Responsible f Standards (IVS)
or regional levels. or Urban Land » IS0 19152:2012 Land
» Parcel ID: Unique Parcel Identifier, Lot Number N Ministry Responsible Administration Domain Model
» Tax Rate: Approved Local Authority/National Taxation Rates for Rural/Agricultural land. (LADM)
» Tax Types: Endowments, Betterments and other Land Value Capture Instruments
» Land Use: Effective Land Use for Taxation Purposes
» Tax Exemptions: Entities that might be exempt from paying Tax, and the degree of exemptions.
» Revenue Generation: Revenue Generated from Local/National Property Taxes
» Default Rates: Degree or Extent of Payment/Default/Arrears including the parcels.
DATA TYPE LAND MARKETS AND TRANSFERS
Tax rates for land transfers, volume of transfers and other information on land value and land markets. » Non-spatial » Ministry Responsible » 1SO 19152:2012 Land
» Land Transfer Taxes: Policy on Taxation of Land Transfers (Capital Gains Tax and Rates) for Finances Administration Domain Model
»  Land Transfer Fees: Policy on Fees of Land Transfers (Stamp Duty, Transfer Duty) » Local Authority (LADM)
» Instrument Number: Reference to Legal Instrument on Transfer Fees and Taxes

» Annual Revenue Generated: Land Transfer Taxes
» Annual Revenue Generated: Land Transfer Fees

» Annual Land Transfers: Number, Type, Size, Value of Land Transactions
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Land use data

The data should reflect the scale and scope of
land use and control through national and local
land use planning practices and process, the
degree to which plans are developed and how
they relate from the national framework to the
regional and local frameworks (Integrated Land
Use Planning). The data should also reflect the use
of the land, the degree of enforcement of land use
regulations, and the management of conflicts that
may arise from alternative land uses.

Land use data is usually distributed over a range
of entities and local authorities. Often these
organizations could also have very different
capacities. This could be a very challenging area
to get information about the national level. The
support of a statistical agency or other national
agencies that have a data and information
dissemination mandate could play an important
role here in developing land use information at
the national level, as well as coordinating with
local governments to get subnational and regional
disaggregated data.

Land use should also be understood in the
context of the expected, designed, or planned
land use and the actual land use. The permitted
land use and the actual land use might not be the
same, and provides important information with
regards to compliance and enforcement of laws,
policies, and other regulations.

Table 4: Land Use Data

DESCRIPTION TYPE

DATA TYPE LAND USE

DATA STEWARD

STANDARD

Land use data is collected at national and local level and could be highly distributed depending on the capacity at local » Spatial
authority levels. Could be contained in zoning plans (typical in local authority areas), land use plans, and town planning
schemes for urban and rural areas. Informal land use data should also be included as appropriate. Shack dwellers federations,
community-based organizations as well as local authorities track land uses that occur outside the formal system.

These community planning instruments should be included in that land use data set for consideration and planning.

» Non-spatial

» Parcel ID: Unique Parcel Identifier, Lot Number, Polygon Feature

» Land Use Type: Land Use Classification Systems (Agriculture, Urban, Residential, Commercial, Conservation Area,
Customary, Informal etc.)

» Administrative Authority: Entity that has jurisdiction over the Land Use
» Land Use Policy: Description of Land Uses and allowable activities.
» Land Use Amendments: Track changes in statutory land use.

» Land Use Map: Show Aggregated land use

DATA TYPE LAND ZONING (LAND USE DESIGNATION)

Ministry responsible
for Local and/or Regional Government

Local and Regional Authorities
National Spatial Data Agency

Community-based organizations s
uch as the Shack Dwellers Federation

1SO 19152:2012
Land Administration
Domain Model
(LADM)

Zoning refers to the intended use of the land, not the actual use. Zoning data is collected at national and local level and could » Spatial » Ministry responsible » 1SO 19152:2012
be highly distributed depending on the capacity at local authority levels. Could be contained in zoning plans (typical in local N Non-spatial for Local and/or Regional Government Land Administration
authority areas), land use plans and town planning schemes for urban and rural areas. N Local and Regional Authorities Domain Model
» Zone ID: Unique Zone Identifier, Zone Number, Polygon Feature N National Spatial Data Agency (LADM)
» Land Use Type: Land Use Classification Systems (Agriculture, Urban, Conservation Area, Customary, Informal etc.) N Community-based organizations
» Zoning Type: Zonation Classification Systems (Residential, Industrial, Commercial, Institutional, Agriculture, Conservation etc) such as the Shack Dwellers Federation
» Administrative Authority: Entity that has jurisdiction over the Zonation
» Zoning Policy: Description of Land Use Zones and allowable activities.
» Zoning Amendments: Track changes in statutory zoning.
» Zoning Map: Show aggregated zonation.
DATA TYPE ENFORCEMENT OF LAND USE AND ZONING
Ensuring adherence to legal land use is critical to planning and ensuring transparency and the good governance of land. » Spatial » Ministry responsible » 1SO 19152:2012
Use of the land should be public and in conformity with the rules and regulations to protect society and the environment N Non-spatial for Local and Regional Government Land Administration
from harm and sustain the land for future use. N Local and Regional Authorities Domain Model
» Enforcement Policy: Outline the rules and regulations, including penalties for non-compliance for land use and zonation. N National Spatial Data Agency (LADM)
» Enforcement Mechanisms.: Outline how Enforcement Policy is implemented, including statutory power and powers of investigation. N Community-based organizations
» Land Use and Zoning Amendments: Policy and Procedures for Changing/amending the land use or zonation (Including such as the Shack Dwellers Federation
fees payable and other value capture instruments).
» Land Use Profile: Number, Type, Size, Value of Land Uses
» Zonation Profile: Number, Type, Size, Value of Zones
» Land Use Change: Show Changes in land use
» Zoning Change: Show changes in zoning
DATA TYPE PUBLIC LAND INVENTORY
Public lands are often treated differently from the local authority or government-owned land. A public land inventory would » Non-spatial » Local Authorities. » 1SO 19152:2012

typically capture the land use and even cover for a range of public land parcels and uses. Some of this information might be
contained in the Land Registry, but it is good practice to document public land separately.

» Parcel ID: Unique Parcel Identifier, Lot Number
» Public Land Inventory: Location, size, use dimensions of all public land.
» Public Land Transfers: The location, size, use land rationale for public land that has been alienated.

» Alienation: Policy and Procedures for the alienation of public land, including compensation.

» Use of Public Land: Name of Entity using Public Land, including terms and conditions. Date that rights were alienated
and duration of such rights.

» Revenue from Public Land: Revenue Generated from Public Land (Rental, Parks, Leases etc)

Ministry Responsible
for Rural/Agricultural land.

Ministry Responsible for Urban Land
National Spatial Data Agency

Land Administration
Domain Model
(LADM)
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Land development data

Land development data may refer to the
construction of new physical infrastructure,
both private and public. This would include
information on the licenses and permits
required for construction to take place, the
approvals process as well as enforcement to
ensure adherence to the conditions provided
in terms of the new constructions. It could also
relate to the process of changing land use and
the alienation of public land for private use as
well as the expropriation of private land for
public use. This may be tracked through local
authority permits and approvals for building
permits, land use permits and land value
capture mechanisms and the distribution

of development costs.

Table 5: Land Development Database

DESCRIPTION

DATA TYPE DEVELOPMENT APPROVALS

DATA STEWARD STANDARD

Local authorities are assumed to track, monitor, and enforce development and land use permits. » Spatial
They should also have a database of and budget for development costs as well as land use capture
instruments used.

» Non-spatial

» Development Policy: Policy on land developments approvals, including procedures and
durations. Outline cost and type of applications that may be submitted as well as how
applications are considered.

» Land Development Application: Application number and basic details of the application.

» Object ID: ID of the spatial object relating to the application.

» Application Type: Use Change, Development Proposal, Subdivision, Agriculture, Industry etc
» Application Classification: Policy on the Classification of Development Applications

» Applicant ID: Identification (Natural or Juristic) of Applicant

» Scope of Application: Indication regarding the impact of the application

» Outcome: Outcome of the applications submitted for approval.

» Approved Application: Value, Size, Units, etc. of application approved.

» Rejected Applications: Value, Size, Units, etc. of application rejected.

DATA TYPE EXPROPRIATION OF LAND

Minister responsible » 1SO 19152:2012 Land Administration
for local and/or regional government Domain Model (LADM)

Minister responsible for Land

Local and Regional Authorities

Expropriation of public and private land is inevitable to ensure adequate social and economic » Non-spatial
development in society. Expropriation is often contentious and should be treated with care.

» Expropriation Policy: Outline the rules and regulations,
including compensation for land expropriation.

» Expropriation Purpose.: State the Purpose for which land was expropriated.
» Expropriation Commencement: Date of Start and Completion of Expropriation Process.
» Parcel ID: Clearly identify the location, size, dimensions and value of the expropriated land.

» Parcel Owner: Natural/Juristic Person (Name, Gender, Identification, Citizenship,
Company Registration Number, Country of Registration)

» Compensation: State value of compensation agreed upon, including any value in lieu!

» Expropriation summary: Value, Compensation, Size, Location,
Number of land parcels Expropriated

DATA TYPE LAND CONFLICTS

Ministry Responsible » 1SO 19152:2012 Land Administration
for Local and Regional Government Domain Model (LADM)

Local and Regional Authorities.

National Spatial Data Agency

Expropriation development approvals and the location of land rights may be subjected to conflicts » Non-spatial
and challenges. As part of the land management process systems to manage and adjudicate
these conflicts are necessary.

» Land Conflict Policy: Policy that describes the type and the scope of land conflicts.
These could be about land use, title, customary, inheritance, objections to development
proposals or other types of conflicts.

» Conflict ID: Unique identification of conflicts.

» Type of Conflicts: Describe the nature/type of conflict in line with policy.
» Escalation of Conflict: ADR/Traditional/Lower Court/High Court.

» Status: Resolved/Ongoing/Paused.

» Conflict Description: Describe the conflict. (Issue, Parties, Jurisdiction).
» Outcome: Describe the eventual outcome of the conflict.

» Outcome Summary: The number, type and escalation of conflicts.

Local Authorities » Not Applicable

Ministry Responsible
for Rural/Agricultural land

Ministry Responsible for Urban Land
Judiciary, Traditional Courts, ADR
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Table 6: Other Data Types

DESCRIPTION TYPE DATA STEWARD STANDARD

DATA TYPE ADMINISTRATIVE AND POLITICAL BOUNDARIES

This could be information related to the local, regional, and national government areas of jurisdiction. Could » Spatial » Surveyor General or Equivalent, » 1SO 19152:2012 Land
also include data on traditional authority management areas. » Non-spatial » Minister responsible for Regional/Local Government, Administration Domain
» Powers and Authorities: Policies and laws on the jurisdiction of each level of government. N Minister responsible for Traditional and Indigenous Model (LADM)
» Classification of Jurisdiction: Policy describing the levels of government from local/village level to regional/ Authority Areas
provincial, federal and national government.
» Object ID: ID of the spatial object relating to a level of government
Oth e r d ata types » Description of Object: Name of governing entity, Level of Government, Size, Boundaries
» Restrictions: Summary of Restrictions Applied to the Object Jurisdiction
If gOOd land governance is about being efficient, » Features of Object: Number of Residents, Level of Education, Income, Contribution to National Tax Base,
effective. and transparent while ensuring that the Employment, Primary Industry, Level Of Infrastructural Development
' L » Object Plans: Description of National, Regional Local Development Plans applicable to the area.
processes are autonomous and participatory and ) ) ) )
) » Socio Economic Status of Object: Derived from Census Data
that outcomes are equitable and secure; then
accessible and up-to-date primary and secondary DATA TYPE LAND REFORM DATA
data is needed to measure and assess gOOd This would include data on beneficiaries that have been resettled or rights that have been restituted. » Non-spatial » Surveyor General or Equivalent » 1SO 19152:2012 Land
governance. Other data types that are perhaps »  Land Parcel ID: Land Parcels that have been the subject of a land reform (redistribution, restitution) process. »  Minister responsible for Land Reform Administration Domain
. . . . Model (LADM,
not typically derived from the land administration »  Beneficiaries: Identification and description of beneficiaries. »  National Spatial Data Agency odel ( )
pa radigm, but are Comp|ementa ry toit, may also » Evictions: Identification and description of persons/groups that have been evicted, or have had rights curtailed
be important for gOOd land governance » Value: Value of land that has been redistributed or for which compensation has been paid.
» Size: The amount of land that has been transferred as part of the |=reform process.
At the most basic level this includes data on the »  Compensation: State value of compensation agreed upon, including any value in lieu!
political and administrative boundaries and areas »  Volume: Number and distribution of parcels transferred.
ijUl’iSdiCtiOﬂ, iﬂC|Udiﬂg traditional authority » Impact: Number of Beneficiaries that have been resettled/restituted.
areas or any other areas of Special Jurisdiction » Cost: Spending on land reform initiatives, including fixed, operational and capital costs.
. \ . . . » Benefits: Income and equity benefits derived from land reforms.
This may be described as spatial or simply in text
by virtue of a formal government notification. DATA TYPE NATIONAL CENSUS DATA/SOCIO-ECONOMIC INDICATORS
I\/Iany countries continue to enforce land refo rms, The nation census likely contains information on household access to services, housing and other relevant » Non-spatial » National Statistics Agency » Principles and
and itis importa nt that these reforms are socio-economic indicators linked to land. Recommendations
. ) . N Housing for Population and
considered on their own in terms of performance : ’ Housing Censuses
» Society, Culture and Heritage Revision 3
and outcomes. Data should demonstrate the . eviston
» Business and Economy
nature and extent of these reforms to enable

» Education
subsequent analysis of their efficacy. »  Income

. . . » Demograph
The national census data is an important sy

resource of information and data for
understanding the underlying socio-economic
issues in many countries. Agricultural census
information on activities such as land use,
employment, and production provide critical

data for a modern land administration system.
However information on agriculture may be
incomplete, isolated from other national data,
and as a result may produce inconsistent and
even counter productive agricultural investments.

» Health

» Services and Utilities
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Table 6: Other Data Types (continued)

DESCRIPTION DATA STEWARD STANDARD

DATA TYPE NATIONAL AGRICULTURAL CENSUS/AGRICULTURAL LAND USE INDICATORS

The national agricultural census collects critical information on agricultural activities, such as » Non Spatial » National Statistics Agencies » LSMS-ISA (WB)
agricultural land use, employment, and production, and provides structured data at regular intervals. » Ministry Responsible for Agriculture

» Characteristics of the household dwelling: Non-food household expenditure items, Fund transfers, Food security, Food consumption
» Agriculture and livestock: Access to land, Seasonal agriculture, Livestock, Forestry, Agricultural equipment

» Community: Economy and infrastructure in the village/neighborhood, Characteristics of agriculture in the village/neighborhood, Livestock and negative shocks which the community has been
victim during the last 5 years, Community needs for infrastructure, Local prices Index

DATA TYPE PUBLIC ASSET DECLARATIONS

Ministers and public servants (especially senior civil servants) are often required to declare their » Non-spatial » Minister Responsible for Public Service » Not Applicable
assets and financial interests. Even when this is not required there are often policies in place

to regulate the activities of public officials to ensure that they do not benefit unfairly from their

positions of relative authority with regards to public works.

» Policy on Public Servants Business: Policy that governs public servants work and private business.

» Public Servant identification: Name, gender, year in he/she took office, office/public entity in he/she works

» Assets information: Company directorships and controlling interests, Interests (such as shares and bonds) in companies and business entities, Employment, Interests in trusts, Organizations
and trusts seeking Government funding, Real estate property - property type (house, apartment, building, car, boat, location, current value, acquisition value, ownership percentage, method
of acquisition (bought, donation, inheritance), Wife/Husband/Son/Daughter Properties, Superannuation schemes, Managed investment schemes, Debtors, Creditors, Overseas travel, Gifts,
Discharged debts, Payments for activities.

DATA TYPE BENEFICIAL OWNERSHIP

Freely available register of information on company owners so that business is done in the open, » Non-spatial » Minister responsible for Trade, Business and Commerce » Beneficial Ownership
markets are fair and governments run effectively. Data Standard

» Ownership or Control Statement: Entity, Interested party (a reference to an entity, natural person, arrangement or trust), Details of the interest, Provenance of information for the statement.

» Politically Exposed Person Status Details

» Person Statement: Information known about a natural person at a particular point in time, or from a given submission of information

» Interested party:

» Publication details

» Publisher

DATA TYPE PUBLIC PROCUREMENT

Publication of public tenders, direct contracting, and awarded contracts as open data » Non-spatial » Minister responsible for Trade, Business and Commerce » Open Contracting Data
» Parties (organizations) awarded contracts: : address, contact, ID, name, roles Standard

» Amounts: amount, currency

» Items: quantity, description, ID, unit, value

» Time periods: end date, start date

» Documents: date published, description, document type, format, ID, title, language, URL

» Milestones: description, due date, ID, title

DATA TYPE KEY LAND DATASETS FOR RESILIENCE AND CLIMATE CHANGE

Datasets identified as playing a critical role in decision-making in the four stages of emergency » Spatial » Minister responsible for Land Administration » 1SO 19152:2012 Land
management: risk reduction, readiness, response and recovery, and climate change. N Non-spatial N Dataset owners Administration Domain
For example: Model (LADM)

» People and Property: population, buildings, address, emergency services
» Rivers: Rivers, water catchments
» Land: elevation, aerial imagery, coastline, topo maps

See: https://www.linz.govt.nz/data/linz-data/resilience-and-climate-change/key-datasets-for-
resilience-and-climate-change
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Policies and standards

Policies

The Integrated Geospatial Information framework
(IGIF) (United Nations Statistical Division 2018-
2020) provides a basis and guide for developing,
integrating, strengthening and maximizing
geospatial information management and related
resources in all countries. It has three separate but
connected parts: Part 1 : an Overarching Strategic
Framework, Part 2: an Implementation Guide, and
Part 3: a Country-level Action Plan, which together
serve a country's needs in addressing economic,
social and environmental factors, which depend

on location information in a continually changing
world. It aims to translate high-level concepts

to practical implementation guidance for use

by Member States and does this by leveraging
seven underpinning principles, eight goals and
nine strategic pathways.

The Implementation Guide sets out what is
needed to establish, implement, strengthen,
improve, and/or maintain a national geospatial
information management system and capability.
It focuses on location information that is integrated
with any other meaningful data to solve societal
and environmental problems, and is a catalyst
for economic growth and opportunity and for
understanding and taking benefit from a nation’s
development priorities and the Sustainable
Development Goals.

The UN GGIM Framework for Effective Land
Administration (FELA, 2020) is an overarching
policy guide for Member States when developing,
renewing, reforming, strengthening, modernizing,
or monitoring land administration.

It seeks to:

» implement the Integrated Geospatial
Information Framework to the land
sector, and support the achievement
of the Sustainable Development Goals;

» develop a comprehensive vision for
understanding, advocating and promoting
effective land administration;

»  provide strategic guidance towards
country-specific action plans to be prepared
and implemented;

» advocate continuous strengthening of land
administration and management procedures,
techniques, and tools; and

» enhance multilateral partnerships through
policy discourse or harmonization for effective
land administration with a view to further
guiding existing policies in Member States.


https://ggim.un.org/igif
https://ggim.un.org/igif
https://ggim.un.org/IGIF/part1.cshtml
https://ggim.un.org/IGIF/part2.cshtml
https://ggim.un.org/IGIF/part3.cshtml
https://ggim.un.org/meetings/GGIM-committee/10th-Session/documents/E-C.20-2020-29-Add_2-Framework-for-Effective-Land-Administration.pdf.
https://ggim.un.org/meetings/GGIM-committee/10th-Session/documents/E-C.20-2020-29-Add_2-Framework-for-Effective-Land-Administration.pdf.

The FELA is relevant for developing and

developed countries, all jurisdictions and all other
stakeholders. It has four parts: the contextual
background and drivers for FELA; the definition of
effective land administration and how that relates
to the Sustainable Development Goals; a high-
level vision statement, goals, requirements, and
outcomes; and nine pathways for effective land
administration, including a series of priority actions
as guidance for implementation.

The Addis Ababa Declaration on Geospatial
Information Management towards good land
governance for the 2030 agenda (Fourth High
Level Forum on UN Global Geospatial Information
Management, 2016), amongst other resolutions:

» promotes cooperation between and
among all UN-GGIM regional committees
in setting up global frameworks, common
standards and application of best practices
in geospatial information management, and
also collaboration in implementing UN-GGIM
regional action plans for achieving good and
sustainable land governance; and

» embraces “open data and standards, innovative
and creative approaches and platforms that are
fit-for-purpose to collect and collate, share and
distribute geospatial and land information needed
to address the diversity and complexity within the
land sector with the singular aim to improve and
secure land and property rights for all.”

The 14 Global Fundamental Geospatial Data
Themes (United Nations Committee of Experts
on Global Geospatial Information Management
(UN-GGIM), 2019) are Global Geodetic Reference
Frame, Addresses, Buildings and Settlements,
Elevation and Depth, Functional Areas,
Geographical Names, Geology and Soils, Land
Cover and Land Use, Land Parcels, Orthoimagery,
Physical Infrastructure, Population Distribution,
Transport Networks, Water.

These themes are considered fundamental to
strengthening a country's geospatial information
infrastructure. Implementing them will require
National Geospatial Information and Mapping
Agencies, National Statistical Offices and other
institutions to integrate information to produce
standardised, fundamental data, for use within
Member States, and to support initiatives such
as the implementation of the 2030 Sustainable
Development Agenda and its 17 Sustainable
Development Goals (SDGs). They are also a key
supporting foundation for overarching policies,
such as the Integrated Geospatial Information
Framework.

Open licensing policies have been set by mostly
developed countries, requiring government
agencies to release their non-personal,
unrestricted data in open formats, allowing

legal re-use. A typical example is the New
Zealand Government Open Access and Licensing
framework, which recommends the use of the
Creative Commons suite of International Licences.
Similar policies have been set by Canada and the
United Kingdom. Namibia has passed an open
data policy as a spatial data infrastructure policy,
and has agreed to and listed the category of 97
data types that must be open; many government
departments have not yet complied with that
policy. The Africa Data Revolution Report 2018
reports that only 6% of all data (28 out of 420
datasets assessed) is openly licensed in compliance
with the criteria laid out by the Open Definition.
Open licence terms are used by statistical offices in
Botswana, Senegal, Rwanda, and Somalia, as well
as open data portals in Cote d'lvoire, Eritrea, Kenya,
and Mauritius. Usually, websites provide copyright
notes but do not apply licence terms dedicated

to the website’s data; in rare cases a Creative
Commons Attribution (CC-BY) licence was being
used. More common are bespoke terms that are
compliant with the Open Definition. 14.5% of all
data (61 out of 420 datasets assessed) is provided
in at least one machine-readable format.
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https://www.nationalarchives.gov.uk/documents/information-management/uk-government-licensing-framework.pdf
https://cms.my.na/assets/documents/p1a1lgd9ll1s0q19ncq5gilf1ggh1.pdf
http://webfoundation.org/docs/2019/03/Africa-data-revolution-report.pdf

Open data advocates have to be informed about
developments in a number of countries with regards
to recognizing and formulating policies and principles
about concerns from Indigenous communities and
their data sovereignty. Valuable discussions are
taking place in Canada concerning the dissemination
of open geospatial data and First Nations Data
Rights while in New Zealand Maori data sovereignty
is widely sought. Te Mana Raraunga, the Maori Data
Sovereignty Network, advocates for “Maori rights and
interests in data to be protected as the world moves into
an increasingly open data environment.”

Standards

Countries developing, reforming, or implementing
land governance systems should apply the
international standards and specifications for
effective land and geospatial administration which
are designed to assist them at all stages:

The ISO 19152:2012 Land Administration Domain
Model (LADM) is the fundamental international
land administration data standard. It contributes to
the Sustainable Development Goals: 1, 2,11,14 and
15. Its purpose is to:

» define a reference model covering basic
information-related components of land
administration (including those over water
and land, and elements above and below the
surface of the earth);

»  provide an abstract, conceptual model with
four packages related to parties (people and
organizations); basic administrative units, rights,
responsibilities, and restrictions (ownership
rights); spatial units (parcels, and the legal
space of buildings and utility networks); spatial
sources (surveying), and spatial representations
(geometry and topology);

» provide terminology for land administration,
based on various national and international
systems, that is as simple as possible in order
to be useful in practice and provides a basis for
national and regional profiles; and

» enable the combining of land administration
information from different sources in a
coherent manner.

The Open Geospatial Consortium (OGC) Standards
and Resources which members developed to make
location information and services FAIR - Findable,
Accessible, Interoperable and Reusable. Software
developers use them to build open interfaces and
encodings into their products and services.

These standards address specific interoperability
challenges, such as publishing map content on
the Web, exchanging critical location data during
disaster response & recovery, and enabling the
fusion of information from diverse Internet of
Things (IoT) devices.

OGC's Abstract Specifications describe the
conceptual foundation upon which OGC standards
are built. 0GC’s Member-Developed Standards

are developed by OGC members inside the 0GC
Technical Committee. 0GC's Community Standards
are widely-used specifications developed external
to OGC but endorsed by OGC members as being a
valuable part of the OGC Standards Baseline.

The INSPIRE Implementing Rules on interoperability
of spatial data sets and services (IRs) and Technical
Guidelines (Data Specifications) for the European
Community specify common data models, code
lists, map layers and additional metadata on the
interoperability to be used when exchanging spatial
datasets. They cover datasets which come under
one or more of 34 spatial data themes which match
the data types in this Open Up Guide.

The ISO/TC 211 Multi-Lingual Glossary of Terms
(MLGT) has been compiled from International
Standards developed by ISO/TC 211 to encourage
consistency in the use and interpretation of
geospatial terms. It is being made freely available
to all interested people and organizations. It is
available in two formats:

»  Original Microsoft Excel version: 2020602

Edition ISO/TC211 Multi-Lingual Glossary
of Terms (MLGT)
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»  The newly developed, online edition of the
Multi-Lingual Glossary of Terms (MLGT) is
available at Geolexica

LandVoc, a standards controlled vocabulary
developed by the Land Portal Foundation, covers
concepts related to land governance. It consists of
310 concepts organized hierarchically and is available
in a multitude of languages, including English, French,
Spanish, Portuguese, Knmer, Vietnamese, Burmese,
Thai, Swahili and Arabic. LandVoc goes beyond the
sphere of land related matters by connecting to

and exchanging information with other databases
linked to other vocabularies. It is an AGROVOC sub-
vocabulary hosted by FAO.

Cadastre and Land Administration Thesaurus
(CalAThe) is a thesaurus for the domain of cadastre
and land administration. It is encoded as a Simple
Knowledge Organization System (SKOS), according
to specifications developed by the World Wide Web
Consortium (W3C). As of December 2019, CaLAThe
is hosted at the OGC Definitions Server.

The EITI, the Global Standard for the Good
Governance of Oil, Gas and Mineral Resources,
provides a framework and a process for promoting
greater transparency and accountability in the oil,
gas, and mining sectors. The EITI Requirements
related to a transparent legal framework and
awarding of extractive industry rights include:

legal framework and fiscal regime; contract and
license allocations; register of licenses; contracts;
beneficial ownership; and state participation in the
extractive sector.

Committee for Mineral Reserves International
Reporting Standards. This identifies the countries
and their standards which comply with the
principles of the CRIRSCO Template.

The Open Contracting Data Standard (OCDS) enables
disclosure of data and documents at all stages of

the contracting process by defining a common data
model. It was created to support organizations to
increase contracting transparency, and allow deeper
analysis of contracting data by a wide range of users.

The Beneficial Ownership Data Standard serves
as a solid conceptual and practical framework for
collecting and publishing beneficial ownership
data, and enabling the resulting data to be
interoperable, more easily reused, and of higher
quality. This common data standard enables the
exchange of data between implementing countries
and allows for a rapid build-up of best practice

on collecting, storing, and publishing beneficial
ownership data.

The Open Up Guide: Using Open Data to
Combat Corruption identifies priority datasets,
including asset and pecuniary declarations,

open standards, and open data use-cases that
governments, civil society, and other stakeholders
can focus on to tackle corruption at all levels and
to respond to increasingly complex corruption
networks. This is complemented by the World
Bank's 2019 publication, Getting the Full Picture
on Public Officials: a How-To Guide for Effective
Financial Disclosure.



https://www.geolexica.org/
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https://star.worldbank.org/sites/star/files/getting-the-full-picture-on-public-officials-how-to-guide.pdf
https://star.worldbank.org/sites/star/files/getting-the-full-picture-on-public-officials-how-to-guide.pdf
https://star.worldbank.org/sites/star/files/getting-the-full-picture-on-public-officials-how-to-guide.pdf

Gaps and
challenges

CURRENT STATE

Primary land tenure data is released for public

use in only a very small number of countries
globally. Governments rarely publish their primary
land use, value and development data as open
data. Some national and local governments sell
their land and property sales data, thereby earning
revenue to assist with the costs of maintaining
their information systems but restricting access
for many. Releasing land governance data in many
countries has significant technical, institutional,
and financial barriers; in some cases, reliable,
formal land tenure data does not exist at all,
metadata is inadequate, the date of the resource
and its source are unknown and there are no
formal custodians for the data. Government
officials may be embarrassed if the data they open
up is inadequate, as this might suggest that their
performance is inadequate. When improving this
situation, countries and international organizations
can use common standards and policies to protect
personal and restricted data and to ensure reliable
and consistent data formats and legal data use

at local and global levels.

SOCIAL AND POLITICAL CONCERNS

Reform without political will, an open legal and
regulatory property rights framework, and effective
land administration is risky. Opening up land
governance data is primarily about improving the
performance of the responsible agents of land
administration, which is the government. Improving
access to land governance data must therefore
also be geared towards enabling government
departments to make use of and improve

their performance, decision making, and policy
development. Reform is likely to be less successful
if there is no clear benefit for improved governance
and if reforms are simply seen to create additional
work for these departments. Similarly, if there is

no information law and confidence that personal
data is protected, society may be adversely
affected by open data reforms. Improving trust
and transparency are fundamental. Whistleblowing
legislation in some countries may also require a
protection infrastructure for whistleblowers.

INCREASE TRUST

Citizens in many countries are not confident
that their privacy and security is being protected
at local and national levels. The lack of
transparency and openness in land information
systems disproportionately affects vulnerable,
indigenous, and marginal groups in society,
particularly women and ethnic minorities. Large
donor investments in land registration systems
currently make few resources available to enable
open data. The introduction and upgrading of
land information systems requires that major
foundational work accompanies such reforms;
namely a transparent legal and regulatory



framework for property rights, a functioning land
administration system, and tools and techniques
for online support.

REDUCE INEQUITY

While better access to land governance data

and information contributes to improved equity
and combating corruption in society, there is a
potential for negative outcomes. When access to
data and information in many countries is unequal,
it may result in land grabbing and resource
appropriation as those with the resources to access
this information may analyse and use it at the
expense of the public and traditional/indigenous
communities. This is one of the primary motivations
for acknowledging Indigenous Data Sovereignty.
Data and land administration authorities need to be
mindful of this and develop legal infrastructures and
operational policies to manage these aspects.

COST OF LAND GOVERNANCE DATA REFORM

The cost of opening up land governance data
remains a challenge for many countries in the
face of other pressing considerations. The most
cost-effective time to design and build information
systems which are ‘open by default’ is when
countries are introducing or upgrading their land
administration systems. System design that equally
protects personal and restricted data and sets up
business as usual publication of public (i.e., non-
personal and unrestricted) data in open formats is
less costly when introduced from the outset.

CONSIDER PUBLIC/COMMERCIAL PARTNERSHIP

Increasing access to, and enabling the collection,
publication, and use of open land governance
data, should not be seen as the prerogative of
the government alone, but rather of a broad
partnership between citizens, the public, and
commercial sectors. While governments have
the primary responsibility for the collection, use,
and publication of primary land governance data,

commerce and the public also collect a significant
amount of data and information. Work to combine
government and private data and to ensure that
an environment is built up that encompasses this
tripartite approach requires commitment and
leadership by all parties.

INTRODUCE OPEN DATA POLICY
AT NATIONAL LEVEL

Realizing the benefits of open access to data and
information needs modern intra-governmental
policy and legislative environments. Countries
must introduce policy for the collection, storage,
stewardship, publication, and use of all of the
government's data types followed by regulations
managing particular functions, for example,

land governance. These instruments will set the
foundations for data use and analysis and to
address the problems that the government and
the public face. They will also encourage legal and
innovative reuse of open data to assist the country
economically and socially.

IMPROVE ACCESSIBILITY OF SPATIAL DATA

With the increasing availability and use

of geographic information systems, many
governmental organizations, private companies,
and academic researchers have expanded the
quantity, accuracy, and types of their spatially
referenced data. Central and local governments
and the private sector are now collecting baseline
spatial data, such as geodetic data, once and
sharing it. This is reducing duplication of effort and
addressing the underutilization of this information
that is created at considerable cost and effort.

It is equally important that this information

is accessible and that users do not have to
download hardware and software to access it. A
simple interface and easy open source tools are
needed to allow easy exploration of the geospatial
data. This could help address concerns that
governments are lagging behind the private sector,
for example, Google Earth.




WORKING WITH ALL WHO COLLECT
AND MANAGE LAND DATA

In some developing countries, land governance
data is produced by local governments or even
by private and community groups. Some local
or municipal governments are afraid of what the
private sector might do with the data. A national
land governance policy is needed to ensure that
all data producers collect, maintain and make
available accurate, standardised and updated
data. The policy should also set guidelines to
ensure that the data producers work together
with national authorities as these national
authorities are established or expanded.

RAISING ANALYTICAL CAPABILITY

As primary and secondary land data are made
more open, it is essential that the capability to
use the data for analysis, decision making, and
policy development is put in place. Data coming
from different sources and custodians (public
and private) will need to be layered and
integrated for advanced information analysis.
Developing the capabilities for private and public
officials and users to gain analytical and data
science skills should be a top priority.

DIGITIZATION OF DATA AND
DIGITIZATION OF PROCESSES

Many land registers only offer analogue and

paper-based land governance data and information

which makes searching, retrieving, and analysis

of a large number of transactions a slow and
arduous task. Programs to convert this information
into digital records (digitizing) are slow, arduous,
and expensive in terms of financial and human
resources. When digitizing the data, organizations

(private and public) must also convert their business

processes (digitalization) in order to fully derive the
benefits of access to digital data and information.
This will require detailed consideration of whether
to include this work in a full reform of their land
administration systems or to carry it out separately.

Digitization and digitalization of public data,
government departments and commercial
enterprises remain a crucial challenge to overcome
if the benefits of open access to land information
are to be realized.

BUILD VALUE-ADDED GOVERNMENT
SERVICES WHICH UTILISE OPEN LAND
GOVERNANCE DATA

To address concerns that making public land data
open for all to use means losing a revenue stream,
authorities could offer value-added services built
on top of the core provision of the open data.

This revenue could replace what was accrued when
there were charges for the data and create long
term core data-based government services which
other agencies can use and rely on. It is unlikely
that a change of government would close access
to the data if that would mean that key government
services would close down.



Use cases

Kenya OGP National Action Plan 2020-2022. This plan includes several activities related to land
governance data:

»  Enforce digitization of records held by public institutions

»  Support development of GIS Labs and digitization of development control

» Regularly update Kenya Open Data Portal

» Adopt Open Contracting Data Standard to cover all stages of public procurement
»  Publish details of companies winning mining contracts

»  Strengthen and encourage whistleblowing

Demandes de valeurs fonciéres |land valuation is an open platform for public data by the Ministry
of Finance in France.

The Land Information Inquiry Portal-Rwanda

This Portal was established by the Rwanda Land Management and Use Authority to help land
owners, citizens, organizations, and investors to confirm land ownership; to check the land
area, land use and the planned use; to verify whether a parcel has any restriction or a mortgage
registered against it; and if there is an ongoing transaction on the parcel.

The voluntary reports on the SDG land-related indicators 1.4.2, 5a1 and 5a2 by Kenya, Namibia
and Rwanda include their progress toward meeting the SDH land-related indicators.

National Spatial Data Infrastructure (NSDI) for Namibia promotes an open and
reliable supporting environment that facilitates access to geospatial information for society
and government.

openAFRICA, Africa’s Largest Volunteer Driven Open Data Platform, aims to be the largest
independent repository of open data on the African Continent.



https://www.opengovpartnership.org/members/kenya/
https://www.data.gouv.fr/en/datasets/demandes-de-valeurs-foncieres/
https://landinformation.rlma.rw/
https://sustainabledevelopment.un.org/content/documents/26360VNR_2020_Kenya_Report.pdf
https://sustainabledevelopment.un.org/memberstates/namibia
https://dashboards.sdgindex.org/profiles/rwa
http://geofind.nsa.org.na
https://africaopendata.org/

Landonline, New Zealand's official land register, is primarily “the transaction centre for property
professionals and local councils to carry out land dealings efficiently and securely online.” It also has

a public online NZ land record search where anyone can search for a title, instrument, survey or
parcel, and pay for a copy of the record. The LINZ Data Service delivers property and ownership,
topographic, hydrographic, geodetic, and electoral address open data in commonly used location
information formats and via a web-service using global open standards. Most is licensed for the
widest re-use possible under the Creative Commons Attribution 4.0 International licence (CC-BY)
licence. Exceptions are layers of data containing property ownership which need a special licence
to cover protection under Domestic Violence legislation.

The following potential use cases suggested at the April 2021 Open Up Guide workshop are being
further investigated:

»  Cost benefit studies show that businesses are downloading land governance data and
integrating it into their own applications and products.

»  Online data saves costs for governments as they do not have to dedicate time and resources
to responding to citizens' requests in analog.

» Utilities use data to find out to whom they could offer their services, e.g. mapping of
homesteads offers them potential customers, providing economic benefits downstream.

»  The real estate market uses reliable, ideally complete, and accurate property evaluation and
planning data to stimulate land market activity which is beneficial to governments and the public.

» Insurance companies use data for property and other types of insurance.

» The Namibian data agency has signed an agreement with a cell-phone company that has
agreed to fund some of the agency’s activities.

» Land records for agricultural land in India have led to smooth functioning of the market.

»  When data is opened up, people will invent services that were not possible before.



https://www.linz.govt.nz/land/landonline
https://lrs.linz.govt.nz/search/
https://data.linz.govt.nz/
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